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• Reach Technology SLCD controller board and color TFT touchsc
connector and assembled serial cable interface.

• Two AC adapters: 24 V DC (500 mA) with bare leads and 12 V D
(AC adapters are included only with Application Kits 
sold for the North American market).

• Programming cable with level-matching circuitry.

• DE9 to 10-pin serial adapter cable.

• 4 standoffs.

• Getting Started instructions.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

Using the Reach Technology Display
1. Locate the power-supply con-

nector and connect it to the 
bare leads of an AC adapter 
as shown in Figure 2. Pay 
attention to the polarity of the 
power-supply connections. 
Attach the power-supply con-
nector to the display and plug 
in the AC adapter.

2. Use the serial cable interface 
to connect the Reach Tech-
nologies display to an avail-
able COM port on your PC. 
You may have to use a DE9 
extension cable since the 
serial cable interface is short.

3. Start the BMPload.exe 
program on the Reach Tech-
nology supplemental CD. 
Select the serial COM port you are using and a baud rate of 115200. Press the Load BMP List button 
and select the demo.lst file from the Samples\ColorTouchscreen\BMP_Macro folder on the 
Dynamic C supplemental CD. Next, press the Add Macro File button and select the Macros.mac 
file from the same folder on the Dynamic C supplemental CD. Finally press the Store into SLCD 
button to move these files to the Reach Technology display—this may take a few minutes. Press the 
Quit button to exit the BMPload.exe program when done.

4. Disconnect the serial cable interface from your PC COM port and use the serial adapter cable to connect 
header J3 on the Prototyping Board to the serial cable interface as shown in Figure 2 to establish a serial 
connection with the RCM3720. Reconnect the programming cable to the PC COM port if you had to dis-
connect it in order to use the PC COM port for the serial connection to the Reach Technology display in 
the above steps.

Where Do I Go From Here?
You are now ready to go on to other sample programs and to develop your own applications. Application 
Note AN411, Color Touchscreen Application Kit, takes you through loading and using the sample pro-
grams included with the Dynamic C supplemental CD, and describes Z-World’s software drivers. The 
RCM3700 User's Manual provides complete hardware reference information and describes the software 
function calls for the RCM3720 and the Prototyping Board. The Reach Technology supplemental CD con-
tains additional information about the display and its specifications.
Troubleshooting

• The files loaded to the Reach Technology display should be from the Dynamic C supplemental CD.
• Use the Dynamic C Help menu to get further assistance with Dynamic C.
• Check the Z-World/Rabbit Semiconductor Technical Bulletin Board at www.zworld.com/support/bb/.

• Use the Technical Support e-mail form at www.zworld.com/support/.

NOTE: If you purchased your Color Touchscreen Kit through a distributor or through a Z-World 
or Rabbit Semiconductor partner, contact the distributor or partner first for technical support.

Figure 3.  Reach Technology Display Connections
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Color Touchscreen Application Kit
Getting Started

Application Kit Contents
• Dynamic C® CD-ROM, with complete product documentation on disk.

• Supplemental CD with sample programs and information related to Color Display Application Kit.

• Reach Technologies supplemental CD with software for color display.

• RCM3720 RabbitCore module.
• RCM3720 Prototyping Board with RS-232 circuits installed.
bit, and Dynamic C are registered trademarks of their 
lders.

reen with screw-terminal power 

C, 1 A with 3-pin connector. 

lling Dynamic C®

he Dynamic C CD from the Applica-
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.exe program in the root directory 
ynamic C CD. Install the software 

e Dynamic C supplemental CD after 
tall Dynamic C

http://www.zworld.com/support/bb/index.html
http://www.zworld.com/support/questionSubmit.shtml


Attach the DE9 connector end of the programming cable to a COM (serial) port on the PC. Dynamic C 
uses a COM port to communicate with the target system. The default selection is COM1, but you can 
select a different COM port when you install Dynamic C or when you run it.

Connect the 10-pin connector of the programming cable labeled PROG to header J2 on the RCM3720 
as shown in Figure 2. Be sure to orient the marked (usually red) edge of the cable towards pin 1 of 
header J2. (Do not use the DIAG connector, which is used for a regular serial connection.)

NOTE: Be sure to use the programming cable (part number 101-0542) supplied with this kit that 
has blue shrink wrap around the RS-232 converter section located in the middle of the cable. 

Figure 2.  Connect Programming Cable and Power Supply

ower
connections have been made, you can connect power to the Prototyping Board. Con-
pter with the 3-pin connector to 3-pin header J1 on the Prototyping Board as shown in 
 The connector may be attached either way as long as it is not offset to one side—
f J1 is always connected to the positive terminal, and either edge pin is negative.

adapter. The power LED beside the RESET button on the Prototyping Board should 
M3720 and the Prototyping Board are now ready to be used. The RESET button is 

 Prototyping Board to allow a hardware reset without disconnecting power.

r-Supply Connections

ctor allows you to connect your own power supply—connect the center pin to the pos-
itive terminal, and connect either edge pin to the negative terminal. The power supply should deliver at 
least 200 mA at 7.5 V–15 V DC.

Starting Dynamic C
Once the RCM3720 is connected as described in the preceding pages, start Dynamic C by double-clicking 
on the Dynamic C icon or by double-clicking on dcrabXXXX.exe in the Dynamic C root directory, 
where XXXX are version-specific characters. Dynamic C uses the serial port specified during installation.
If you are using a USB port to connect your computer to the RCM3720, choose Options > Project 
Options and select “Use USB to Serial Converter.”

ple Program
u to open the sample program PONG.C, which is in the Dynamic C SAMPLES folder. 
y F9 to compile and run the program. The STDIO window will open on your PC and will 
quare bouncing around in a box.
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Programming cables from other Z-World or Rabbit Semiconductor kits were not designed to 
work with RCM3720 modules.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use some 
RS-232/USB converters with the programming cable supplied with the Ethernet Connection 
Kit. An RS-232/USB converter is available through the Z-World Web store.

Run a Sam
Use the File men
Press function ke
display a small s
Hardware Connections
To facilitate handling the Prototyping Board, snap in the four standoffs to the four holes at the corners 
on the bottom side of the Prototyping Board before continuing with the remaining steps.

1.  Attach Module to 
Prototyping Board
Turn the RCM3720 module so that 
the Ethernet jack is on the left as 
shown in Figure 1 below. Insert the 
module’s J1 header into the J5 socket 
on the Prototyping Board. The shaded 
corner notch at the bottom right cor-
ner of the RCM3720 module should 
face the same direction as the corre-
sponding notch below it on the Proto-
typing Board.

NOTE: It is important that you 
line up the pins on header J1 of 
the RCM3720 module exactly 
with the corresponding pins of 
the J5 socket on the Prototyping 
Board. The header pins may 
become bent or damaged if the 
pin alignment is offset, and the 
module will not work. Perma-
nent electrical damage to the 
module may also result if a mis-
aligned module is powered up.

Press the module’s pins firmly into the Prototyping Board socket.

2.  Connect Programming Cable
The programming cable connects the RCM3720 to the PC running Dynamic C to download programs 
and to monitor the RCM3720 module during debugging.

Figure 1.  Install the RCM3720 Module
on the Prototyping Board
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Hardware Connections
To facilitate handling the Prototyping Board, snap in the four standoffs to the four holes at the corners 
on the bottom side of the Prototyping Board before continuing with the remaining steps.

1.  Attach Module to 
Prototyping Board
Turn the RCM3720 module so that 
the Ethernet jack is on the left as 
shown in Figure 1 below. Insert the 
module’s J1 header into the J5 socket 
on the Prototyping Board. The shaded 
corner notch at the bottom right cor-
ner of the RCM3720 module should 
face the same direction as the corre-
sponding notch below it on the Proto-
typing Board.

NOTE: It is important that you 
line up the pins on header J1 of 
the RCM3720 module exactly 
with the corresponding pins of 
the J5 socket on the Prototyping 
Board. The header pins may 
become bent or damaged if the 
pin alignment is offset, and the 
module will not work. Perma-
nent electrical damage to the 
module may also result if a mis-
aligned module is powered up.

Press the module’s pins firmly into the Prototyping Board socket.

2.  Connect Programming Cable
The programming cable connects the RCM3720 to the PC running Dynamic C to download programs 
and to monitor the RCM3720 module during debugging.

Attach the DE9 connector end of the programming cable to a COM (serial) port on the PC. Dynamic C 
uses a COM port to communicate with the target system. The default selection is COM1, but you can 
select a different COM port when you install Dynamic C or when you run it.

Connect the 10-pin connector of the programming cable labeled PROG to header J2 on the RCM3720 
as shown in Figure 2. Be sure to orient the marked (usually red) edge of the cable towards pin 1 of 
header J2. (Do not use the DIAG connector, which is used for a regular serial connection.)

NOTE: Be sure to use the programming cable (part number 101-0542) supplied with this kit that 
has blue shrink wrap around the RS-232 converter section located in the middle of the cable. 
Programming cables from other Z-World or Rabbit Semiconductor kits were not designed to 
work with RCM3720 modules.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use some 
RS-232/USB converters with the programming cable supplied with the Ethernet Connection 
Kit. An RS-232/USB converter is available through the Z-World Web store.

Figure 1.  Install the RCM3720 Module
on the Prototyping Board
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Figure 2.  Connect Programming Cable and Power Supply

3.  Connect Power
When all other connections have been made, you can connect power to the Prototyping Board. Con-
nect the AC adapter with the 3-pin connector to 3-pin header J1 on the Prototyping Board as shown in 
Figure 2 above. The connector may be attached either way as long as it is not offset to one side—
the center pin of J1 is always connected to the positive terminal, and either edge pin is negative.

Plug in the AC adapter. The power LED beside the RESET button on the Prototyping Board should 
light up. The RCM3720 and the Prototyping Board are now ready to be used. The RESET button is 
provided on the Prototyping Board to allow a hardware reset without disconnecting power.

Alternate Power-Supply Connections

The 3-pin connector allows you to connect your own power supply—connect the center pin to the pos-

��
 

 
#
�
$

�
�
�

%�&
�
�

�
!
'

�
(
)

�
(
�

�
(
*

�
�
�

�
#
�

�
#
)

�
+
�

�
�
�

�
�
�

�
�
�

�
�
*

�
�
)

�
+
'

�
+
�

�
#
�

!
"
�

!
"
�

%�
(
�

�
�
�

%�&
,
�

�
!
*

�
(
�

�
(
�

�
�
�%
�
!
�

�
�
�%
�
!
�

�
+
*

�
+
�

�
#
*

�
#
�

�
#
�

�
+
)

�
�
)

�
�
�

�
�
�

�
�
'

!
"
�

!
"
�

%�
(
�

�
�
�

%��
�
�

�
!
*

�
(
�

�
(
�

�
�
�%
�
!
�

�
�
�%
�
!
�

�
+
�

�
+
�

�
#
*

�
#
�

�
#
�

�
+
)

�
�
)

�
�
�

�
�
�

�
�
'

��
 

��
��

�
�
�

�	�
�


�
!
'

�
(
)

�
(
�

�
(
*

�
�
�

�
�
)

�
+
'

�
+
�

�
#
�

�
#
�

�
#
)

�
+
�

�
�
�

�
�
�

�
�
�

�
�
*

-�

�+�

�#*

�+'

�+*

�,�

�,�

���

���

-�-�

-'.�

�*
��

�/ ��

��

���

.��
��

���

������)

�'

-�

#$�

��0�*�)���&$&$1��"!�#&���

�2�

�
2
�

�2*

�2�

�2/

�2�)

�2��

�2��

�2��

�2��

�2��

�2�'

�
2
�

�2��

�2�� �
2
'

.2/

�2��

�2�)

�2��2�

�
2
'

.2*

�
2
�

�
2
�

�2/ �
2
�

.2�

�
2
�

�2���
2
�

.2�

.2�

.2�

�
2
�

�2*

-�

�� 

!"�

�
+
*

�
�

�
�

�
�

.�

��

��

��

�'

��

��

�
� ��

�
+
�

��

�
#
*

�
�

�
�

�
(�
(
$

�&
,
(�

�
+
'

�
�
�

�
�
�

�
�
� �

�

�
�

� �

� �

�

� �

�

��

-�

��

�
(�
(
$

�&
,
(�

�
�
� �

�

�
�

�����
����	���������	

���������	

������
�����

�
����

�
��

�
�

�
��

�
��

������ �
��

�
�'

���
��/

�
�'

�
�*

�
��

���
��'

��'
��/
���

.����

-��
�*

-��

-�

�
��

�
��

�
�)

�
��

���

��*
��)

���
���

.�

�
'

�����*

����
.�

��/

-�
�

1�

��)

��)

3�

�*��/

4�

4�

���

������

.
��
��

1���*
���

�
��

��/

���
���
��)

���

-�

���

��'

���

$�

���

���
��

.'

���

�
�'

.�

���
��

.��

4�

4�
��������
4'

��*

�
�
�
5

5�


$

�
�
��

�
�
��

�
	

#�6

78���9�����

�
�
&
!

�
��
!

�	��	�  ���
��
��

�
�
&
!

-�

�	����!����
"��	� 
�	���

������	���
��
itive terminal, and connect either edge pin to the negative terminal. The power supply should deliver at 
least 200 mA at 7.5 V–15 V DC.

Starting Dynamic C
Once the RCM3720 is connected as described in the preceding pages, start Dynamic C by double-clicking 
on the Dynamic C icon or by double-clicking on dcrabXXXX.exe in the Dynamic C root directory, 
where XXXX are version-specific characters. Dynamic C uses the serial port specified during installation.
If you are using a USB port to connect your computer to the RCM3720, choose Options > Project 
Options and select “Use USB to Serial Converter.”

Run a Sample Program
Use the File menu to open the sample program PONG.C, which is in the Dynamic C SAMPLES folder. 
Press function key F9 to compile and run the program. The STDIO window will open on your PC and will 
display a small square bouncing around in a box.
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r Touchscreen Application Kit
Getting Started

n Kit Contents
® CD-ROM, with complete product documentation on disk.

al CD with sample programs and information related to Color Display Application Kit.

nologies supplemental CD with software for color display.

abbitCore module.
rototyping Board with RS-232 circuits installed.

Using the Reach Technology Display
1. Locate the power-supply connector and 

connect it to the bare leads of an AC 
adapter as shown in Figure 2. Pay atten-
tion to the polarity of the power-supply 
connections. Attach the power-supply 
connector to the display and plug in the 
AC adapter.

2. Use the serial cable interface to connect 
the Reach Technologies display to an 
available COM port on your PC. You 
may have to use a DE9 extension cable 
since the serial cable interface is short.

3. Start the BMPload.exe program on 
the Reach Technology supplemental 
CD. Select the serial COM port you are 
using and a baud rate of 115200. Press 
the Load BMP List button and select 
the demo.lst file from the Samples\ColorTouchscreen
C supplemental CD. Next, press the Add Macro File button an
the same folder on the Dynamic C supplemental CD. Finally pre
move these files to the Reach Technology display—this may take
to exit the BMPload.exe program when done.

4. Disconnect the serial cable interface from your PC COM port and
header J3 on the Prototyping Board to the serial cable interface a
connection with the RCM3720. Reconnect the programming cabl
connect it in order to use the PC COM port for the serial connecti
the above steps.

5. Open the sample program LCD_PONG1.C, which is in the Dyna
screen folder. Press function key F9 to compile and run the pr
ball bouncing around in a rectangle, leaving a multi-colored trail

Where Do I Go From Here?
You are now ready to go on to other sample programs and to develo
Note AN411, Color Touchscreen Application Kit, takes you throug
grams included with the Dynamic C supplemental CD, and describe
RCM3700 User's Manual provides complete hardware reference i
function calls for the RCM3720 and the Prototyping Board. The Rea
tains additional information about the display and its specifications.
Troubleshooting

• The files used with the Reach Technology display should be from th
• Use the Dynamic C Help menu to get further assistance with Dyna
• Check the Z-World/Rabbit Semiconductor Technical Bulletin Bo

Figure 3.  Reach T

������ ������
Colo

Applicatio
• Dynamic C
• Supplement

• Reach Tech

• RCM3720 R
• RCM3720 P

\BMP_Macro folder on the Dynamic 
d select the Macros.mac file from 
ss the Store into SLCD button to 
 a few minutes. Press the Quit button 

 use the serial adapter cable to connect 
s shown in Figure 2 to establish a serial 
e to the PC COM port if you had to dis-
on to the Reach Technology display in 

mic C SAMPLES\ColorTouch-
ogram. The Reach display will show a 
 behind it.

p your own applications. Application 
h loading and using the sample pro-

echnology Display Connections
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Z-World, Rabbit, and Dynamic C are registered trademarks of their 
respective holders.

• Reach Technology SLCD controller board and color TFT touchscreen with screw-terminal power 
connector and assembled serial cable interface.

• Two AC adapters: 24 V DC (500 mA) with bare leads and 12 V DC, 1 A with 3-pin connector. 
(AC adapters are included only with Application Kits 
sold for the North American market).

• Programming cable with level-matching circuitry.

• DE9 to 10-pin serial adapter cable.

s.

tarted instructions.

00 Processor Easy Reference poster.

on card.

s Z-World’s software drivers. The 
nformation and describes the software 
ch Technology supplemental CD con-

e Dynamic C supplemental CD.
mic C.
ard at www.zworld.com/support/bb/.

Installing Dynamic C®

Insert the Dynamic C CD from the Applica-
tion Kit in your PC’s CD-ROM drive. If the 
installation does not auto-start, run the 
setup.exe program in the root directory 
of the Dynamic C CD. Install the software 
from the Dynamic C supplemental CD after 
you install Dynamic C
020–0086 • 050901–B

• 4 standoff

• Getting S
• Rabbit 30
• Registrati

• Use the Technical Support e-mail form at www.zworld.com/support/.

NOTE: If you purchased your Color Touchscreen Kit through a distributor or through a Z-World 
or Rabbit Semiconductor partner, contact the distributor or partner first for technical support.

http://www.zworld.com/support/bb/index.html
http://www.zworld.com/support/questionSubmit.shtml
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